
 
 

Excel 2016 - Charts 
Charts are used make it easier to understand large quantities of data and the relationship between 
different series of data by displaying series of numeric data in a graphical format.  When you create a 
chart in Excel you will first enter the data on a worksheet and then create the chart.  Excel automatically 
links the data to the chart so that if data is altered, added or deleted, the chart will update accordingly.   

Chart Terms 
You should be familiar with chart terminology so you will know the name of the object you wish to 
modify/add, etc.  A typical style of chart would have an X-axis (horizontal) and a Y-axis (vertical).   

Column Chart terms 
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Scatter Chart terms 
 

 

Types of Charts 
Below are some general guidelines for selecting the best type of chart for the data you wish to present. 

• Column - Shows data changes over a period of time or illustrates comparisons among 
items 

• Line - Shows trends in data at equal intervals 
• Pie - Shows proportional size of items that make up a data series; only shows 1 data 

series 
• Bar - Illustrates comparisons among individual items 
• Area - Emphasizes the magnitude of change over time 
• XY (scatter) - Shows relationships among numeric values in several data series or plots 

two groups of numbers as one series of XY coordinates. 
• Stock - Measures volume and has two axes; one for measuring volume, the other for 

stock prices 
• Surface - Shows optimum combinations between two sets of data (like a topographic 

map) 
• Doughnut - Shows the relationships of parts to a whole, like a pie, but can contain >1 

data series 
• Bubble - Type of scatter chart; compares 3 sets of values with the 3rd displayed as a size 

of a bubble 
• Radar - Each category has its own value axis radiating from the center point 
• Cone, cylinder & pyramid - Creates the specified effects by using shaped data markers 

in 3-D column and bar charts 
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Guidelines to create a chart 
1) Different chart types are suitable for displaying different data sets.  For example, a pie chart only 

displays one series of data, and would therefore be unsuitable for trying to compare more than 
one data range. 

2) Generally speaking, simpler is better.  Cluttering a chart with unnecessary data or too many 
additional objects may dilute the message you are trying to present with a chart. 

3) You may need to consolidate some of your data in order to effectively present it in a chart.  For 
example, you may want to present subtotals for your categories rather than plotting individual 
data items.  Using the built-in subtotals feature of Excel (Data Tab, Subtotals) can often be useful 
in summarizing the data before plotting it.  

4) Charts may be created in Excel and then pasted into other applications such as PowerPoint or 
Word.   By default, the chart is pasted as a link so that if the data changes in Excel, the chart’s 
view will update in any other application where it was pasted.  

Create a Chart  
Select the cells that contain the data and text you want to include in the chart.  Select both the numeric 
data and adjacent row and column headings.  Make sure 
there are no blank rows or columns between the title and 
category headings and the body of the data or Excel will plot 
the blank spaces.  Navigate to the Insert tab, Charts group, 
and select a chart type from the Ribbon.   
  
You will see several options for chart types, and 
then options for each chart type.  You are able to 
preview the charts by clicking on a chart type, and 
highlighting over the options.  Excel will show you a 
live Preview of the chart, so you are able to 
preview what the chart will look like before 
selecting your chart.  If you don’t like the way the 
chart looks, you are able to choose a different 
chart option. 
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Chart Tools 
Any time you have your chart selected, you will see the Chart Tools tab on the 
Ribbon.  If you are trying to make any adjustments to your chart, verify that 
your chart is selected.  If you do not see the Chart Tools tab, this means that 
your chart is not selected.  

Quick Analysis Tool 
The Quick Analysis Tools, which is new to Excel 2013, allows you to select or highlight data and quickly 
analyze using a few options such as Formatting, Charting, Totals, etc. 
 
To use the Quick Analysis Tool, select your data, on the bottom right of you selection you 
will see the Quick Analysis Tool icon.  Click on the icon to see what options you have. 
 
The top tabs will offer various options as to 
what you can do with your data.  You are able 
to mouse over any option to see a live preview 
of each tool, so you can see how your data will 
look before selecting a change to your data. 
 
If you click on Charts tab, you are able to see 
what Charts are available.  You are able to 
mouse over the options to see a visual of the 
chart before actually selecting it.  If none of 
the options will work for you, click on the 
More Charts icon to see all avaliable chart options. 

Recommended Charts 
New in Excel 2013 is a feature called Recommended 
Charts.  Recommended charts will look at your data and 
provide some recommendations for chart types to 
display your data.  To use Recommended Charts, select 
the data that you want to display, click on the Insert Tab, 
and then select Recommended Charts.  
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The Insert Chart window appears with the recommendations for your data.  You are able to click on any 
of the options on the left hand side and see a preview.  If you find a chart that you want, either double 
click on it or select it and hit the OK button.   
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Sometimes what Excel recommends with Recommend charts may not work.   If you don’t see an option 
that works, you can always click on the All Charts tab to pick the specific chart type that you would like 
to display 
 

 
 
From the All Charts tab, you are able to see all of the charts that are available, the different options for 
each type and a Preview.  Once you have found the chart type that you like, either double click on it, or 
select it and hit the OK button.  The chart will now be displayed in your worksheet. 
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Plot Nonadjacent Selections 
Sometimes the data you wish to plot are in rows or columns that are not adjacent to each other.  To 
select and chart nonadjacent selections, begin by selecting the cells in the first row or column. Hold 
down the Ctrl key as you select nonadjacent areas.  When you have all of the data selected that you 
want in your chart, go to the Insert Tab and select the type of chart that you want to display. 
 

 

Plot by manually Selecting data 
If you don’t have your data selected prior to selecting your chart type, or if 
you had the wrong data selected, you can always change your data by 
right click the mouse on the chart and choose Select Data from the 
context sensitive menu. 
 
From the Select Data Source window, make sure your cursor is in the 
Chart data range text box, now navigate your mouse back to the 
worksheet holding your data.  Now click hold and drag your cursor to 
select the data that you want to be displayed in your chart.  When you have the correct data, hit the OK 
Button.  
 

 
 
You may also change your data from the 
Chart Tools Design Tab, and then clicking 
on the Select Data icon. 
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Change a Chart Type 
If you have a chart that doesn’t display the information as you thought it 
may, simply select the chart and click on the Change Chart Type icon from 
the Design tab. 
 
This will bring up the All Charts tab which will allow you to see every chart 
available.  You will also have the Recommended Charts tab that you can 
use to Preview the options that Excel provides to you.  When you have 
found a chart that you like, double click on it or select it and hit the OK 
button. 
 

 

Add, Edit, Remove Series 
Excel charts are dynamic, in that they update when the current data 
changes. If you ever add new data to your spreadsheet that you would 
like to include in your chart, Excel won’t automatically add this data.  To 
include this data, you will have to manually add the series to the chart.  
To add, edit or remove a series of data points to a chart, click on the 
Select Data icon from the Chart Tools Design tab. 
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Add Legend Series 
To Add a new series, click on the Add button under the Legend Entries (Series) title.   
 

 
 
On the Edit Series window, we have two text boxes, Series name and series values.  When you are 
manually adding series to an existing chart, make sure you keep the data consistant.  When you look at 
the existing series, make sure you 
are adding a similar series.  For 
example, if the existing series are 
departments, you wouldn’t want to 
add in a new series called Senior.   
 
The Series name is the name that is 
associated with the data values that 
will be plotted on the chart, this will 
also be the name that appears in the 
Legend, if you display a legend on 
your chart.  This name can be taken from the spreadsheet itself by clicking on a cell, or if there isn’t a 
sufficient name on the spreadsheet, it can be typed into the text box. 
 
Series values is the values that will be plotted on the chart.  Before 
you select the values, make sure all data that is in the series values 
textbox is deleted, this includes the default setting of ={1}.  If the ={1} 
is not deleted, Excel will add this to your selection, which will result in an error. 

Edit a Legend Series 
To Edit a Series, click on the name that you would like to edit, and 
then click the Edit button.  If you would like to change the name, 
you are able to either type in a new name, or use a cell reference to 
a cell within the spreadsheet.  If you need to change the Series 
values, make sure you delete all existing content, before selecting 
your new values.  
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Remove a Legend Series 
To remove a Legend Series, click on the series name that you 
would like to remove and click on the Remove button.  

Rearrange Legend Series 
To change the way your legend series is displayed on your chart, 
click on the name of the series that you’d like to change the location of, and then use the arrow buttons 
to move the series up or down. 
 

 
The series are displayed on the chart bases on how the legend series is set up.  The series on the Top, 
will be displayed on the left, the series on the bottom, will be displayed on the right.  
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The series name on the top will be displayed in the back, the series name on the bottom will display on 
top of all series name above it. 
 

 

Size, Move, and Delete a Chart 
To size the chart, drag the sizing handles until the chart reaches the desired size. 
 

 
 
To move the chart within the same worksheet, simply click on the chart 
until your cursor turns into a plus sign with 4 arrows.  Now click hold and 
drag the chart to a new location.   
 
To move the chart to another 
sheet, select the chart, choose Cut, 
go to the new location, position the 
cursor and choose Paste.   You may 
also click on the chart, navigate to 
the Chart Tools Design Tab, and 
then select the Move Chart icon.  
You will have the option to move 
the chart to a new worksheet 
which you can name, or to move it 
into a current worksheet. 
 
To delete a chart, click on it to 
select it, press the Delete key on 
your keyboard.   
 
The same process will work to 
delete any chart element such as a 
data series, legend, or title.  Click on the element to select it, then press Delete. 

http://ttc.colostate.edu/


 

Excel 2016  - Charts 
© Technology Training Center 
Colorado State University 12 

Swap the Row/Column Data 
After you have created a chart, you may choose 
reverse the series order of data, either on the X or Y 
axis.  A quick way of doing this is by using the Switch 
Row/Column Data icon under the Chart Tools Design 
Tab.  
 
Another way to do this is to click on the Select Data 
icon from the Chart Tools 
Design tab. 

 
 
 
 
 

Format Chart Elements 
Before you can select and modify any chart item, the chart must be activated.  Click on a chart to select 
it.  You will see “selection” handles added to the border indicating it is active.  After activating the chart, 
you can move, modify, and size various elements of your chart such as titles, data labels, and pie and 
doughnut slices by selecting and dragging them.  You can move and resize 
the plot area, the legend, and any graphic objects, such as text boxes and 
arrows that you have created by clicking on the piece and dragging, 
resizing, etc.   
 
When the chart is active, you will see 3 icons on the upper right side of the chart. 

 
Chart Elements:  Add, remove, or change chart elements such as title, legend, and 
gridlines 
Chart Style:  Set a style and color scheme 
 
Chart Filter: Edit what data points and names are available on your chart 
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Chart Elements 
Chart Elements will allow you to add, change, or remove chart elements.  
You can easily change the look of your chart by selecting, or deselecting 
any Element from the Chart Elements window.  
 
Some the elements will have more options for their location on the chart.  
Any time you see a grey right arrow, you will have more options for the 
elements. 
 

 
 
Remember:  You are still able to move the Elements on the chart if you don’t like 
the exact locations of where they are located. 
 
Note:  These options are also available on the Chart Tools Design tab, under the 
Add Chart Element icon. 

Chart Elements Options 
Some Elements will have a More Options… option.  This option will allow for 
formatting of the Box that the element is in as well as the text in the element. 
 

 
 
 
 
 

 
The options that are available are dependent on which element you have selected the More Options 
option from.  This is a good way to change the look of your chart elements. 
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Chart Style 
The Chart Style will show you a few options of prebuilt Styles within Excel.  You are able to click on any 
of the options to see a live change of your chart.  If you do change the styles, you can always go back 
into the Filter option to change your chart back or to a new look. 
 
The color option will allow you to change the colors of the chart.  You are able to preview how they will 
look on the chart by clicking on the color options. 
 
Note:  Style and Color are both separate but can be used in conjunction with each other or on their own. 

                      
 
Note:  These options are also available on the Chart Tools Design Tab. 
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Chart Filters 
The chart filter will allow you to filter the data within 
your chart by selecting various Series or Category labels.  
To change the look of the chart, click the Apply button 
on the bottom of the Filter window.  To get your chart 
back to the original look, click on the Select all check box 
to display all data. 
 
On the Names tab you are able to add or remove the 
Series and Category names.  To make a change take 
effect, click on the Apply button. 
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Chart Themes 
An easy way to color format your chart is to use the color themes built into Excel.  These are the same 
themes that are used in all other Microsoft Office products, so if you are inserting a chart into a 
PowerPoint presentation, you are able to create both the chart and the presentation using the same 
Theme.  That way, when you insert the chart, the colors will match the presentation slides. 
 

 
 
To change the theme, click on the Page Layout tab and then select the Themes dropdown.  You will have 
several theme options that are available to use.  You are able to mouse over the name of the theme and 
see how your chart will change before actually selecting the theme. 
 
If you only want to change the color/format of a single element on the chart, you are able to do this by 
selecting the element within the chart, then navigating to the Chart Tools Format tab.  From the format 
tab, you are able to change the fill, outline, or effects of text and shapes. 
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Quick Layouts 
Once you have created a chart, Excel has created some prebuilt Chart 
Layouts that may be useful.  These options are available on the Chart 
Tools Design tab, under the Quick Layouts icon.  There will be several 
options depending on the type of chart you are using.  This is a quick 
and easy way to develop a chart with the information that you want 
to show.   
 
You are able to see a live preview of any of the Layouts by moving 
your mouse over a particular layout.  To select a layout to use on your 
chart, just click on the one that you want and your chart will be 
updated.  If there are some elements on the chart that you don’t 
want, you can easily delete them or add in new elements. 

Edit Chart Elements 
There may be an instance where 
you want to change an individual 
chart element for example, if you 
want to change the Minimum or 
Maximum of one of the axes, of if 
you want to highlight a certain data 
series in a column chart.   
 
To adjust an element on your chart, 
double click on the chart element.  
When you do this, a Format Task 
Pane will open on the right side of 
the screen allowing you to edit the 
element that you selected.  
Depending on the element that you 
are adjusting, you will have 
different options. 
 
You may also right click on a chart 
element and select Format Axis, Data 
Series, depending on that element that you right clicked on.  
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 To verfiy that you are editing the correct element on the chart, click on 
the dropdown towards the top of the task pane.  (This name displayed 
will be different, based on the element that what double clicked on.)  
When you click on the dropdown, you will see every element that is on 
the chart.  Make sure you have selected the correct element to adjust. 
 
To select another element to adjust, you can choose that element from 
the dropdown, or you can click on the element within the chart.  
Sometimes the names aren’t easy to determine exactly what element is 
going to be changes, so it may be easier to click within the chart to 
select the specific element that you would like to adjust. 

Common Chart element options 
Depending on the chart element that you are changing, you will see 
different options.  Here are some common options and what they will 
adjust. 

•   - Fill & Line – Adjusts the color and fill of the line, the line 
width, dash type, etc. 

•  - Effects – Adjusts the effects of the chart element, adding a shadow, glow, 3-D, etc. 

•  - Size & Properties – Adjust the alignment and text direction 

•  - Options – Adjust bounds and unit increments of an axis, adds tick marks to axes, changes 
the display of a data series within a column/bar chart, etc. 

Adjust Axes bounds 
To adjust an axis bounds, meaning the display of high and low 
numbers that are plotted on the chart, double click on the axis 
that you would like to change. 
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On the Format Axis task pane that opens on the right side of the 
screen, click on the Axis options icon.  This is the bar chart icon that 
will display.  Under Axis options, you will see four other sections, 
bounds is located in the top option, Axis options, click on Axis 
options.  The first options you see are the Bounds.   
 
By default, Excel will automatically choose the bounds based on the 
data that is plotted on the chart.  If you would like to change the 
minimum or maximum, click within the textbox next to one of 
those options and type in the new bounds that you would like to 
see on your chart.  To see a live preview, either click Enter, or 
navigate away from the current textbox. 

Format a Data Series on a Column Chart 
To change the data series on a column chart, double click on one of 
the individual plotted data columns, you may also right click on a 
data series can choose Format Data Series.  On the Format Data 
Series task pane, click on the Fill & Line icon (paint bucket).  You will 
see an option for fill, which will be set to automatic.  If you would 
like to change the fill to a new color, click on the icon to the right of 
color and choose your new color.   
 
There is also a border option.  This is also selected as automatic, so if 
you only change the fill color, Excel will update the border color 
for you.  If you want to change the border color as well, click on 
the icon to the right of color under border to choose a new color 

Format a Data Series on a Line Chart 
To change the data series on a line chart, double click on one of 
the individual plotted data lines, you may also right click on a data 
series can choose Format Data Series.   
 

 
 
On the Format Data Series task pane, click on the Fill & Line icon 
(paint bucket).  You will see an option for line and marker.  To 
change the entire plotted data, so the line and the markers (dots), 
there are three pieces that need to be changed.  On Line, you will 
see an option for color, click on the icon to the right of color to change the line color.  If you look at your 
chart, you will see now that only the line itself has changed.   
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To change the marker colors, click on the Marker option on the 
top, and change both the fill and the border colors to your new 
color.  
 
You will notice that the legend is also updated when you change a 
data series. 
 

 
 
Note:  Make sure when you are changing the colors of a data 
series that you verify that all options are changed to the new color. 
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Insert Shapes and Clip Art 
To insert shapes into your chart, click on the Chart Tools Format tab.  On the right hand side, you will see 
a selection of shapes.  Click on the dropdown menu to see all of the shapes that are available.  You can 
use the Shape Styles to change the look of your shape either before you insert your shape, or by 
selecting it after it is inserted and changing the look. 
 

 

Copy a Chart into Microsoft Word 
Once you have created your chart, you may need to share it in a report that you have created in 
Microsoft Word.  To do this, make sure you have your Word Document open.  Go back into Excel and 
make sure you have the chart selected.  Copy the chart to the clipboard by clicking Ctrl-C.  Now, navigate 
to your open Word Document and simply press Ctrl-V. 
 
By default, the copied chart is linked back to the Excel worksheet.  What this means is that any changes 
you make to the data in Excel, will be reflected on the chart in your Word Document.  If you do not want 
the chart to change based on the data in Excel.  After you have pasted your chart, in the lower right 
hand corner, you will see an icon with a clipboard and Ctrl.  If you click on the Ctrl icon, 
you have the option to select different paste options.  Click on the last icon, the Picture 
icon.  This will paste a picture of your chart as it looks right now. 
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